
Lipidomics Workflow Guide
Agilent 6560 Ion Mobility LC/Q-TOF



Notices

Manual Part Number
D0003136 Revision A.00
July 2021

Copyright
© Agilent Technologies, Inc. 2021
No part of this manual may be 
reproduced in any form or by any 
means (including electronic storage 
and retrieval or translation into a foreign 
language) without prior agreement and 
written consent from Agilent 
Technologies, Inc. as governed by 
United States and international 
copyright laws.
Agilent Technologies, Inc.
5301 Stevens Creek Blvd. 
Santa Clara, CA 95051

Warranty
The material contained in this 
document is provided “as is,” and is 
subject to being changed, without 
notice, in future editions. Further, to the 
maximum extent permitted by 
applicable law, Agilent disclaims all 
warranties, either express or implied, 
with regard to this manual and any 
information contained herein, including 
but not limited to the implied warranties 
of merchantability and fitness for a 
particular purpose. Agilent shall not be 
liable for errors or for incidental or 
consequential damages in connection 
with the furnishing, use, or performance 
of this document or of any information 
contained herein. Should Agilent and 
the user have a separate written 
agreement with warranty terms 
covering the material in this document 
that conflict with these terms, the 
warranty terms in the separate 
agreement shall control.

Technology Licenses 
The hardware and/or software 
described in this document are 
furnished under a license and may be 
used or copied only in accordance with 
the terms of such license.

Restricted Rights Legend
U.S. Government Restricted Rights. 
Software and technical data rights 
granted to the federal government 
include only those rights customarily 
provided to end user customers.  
Agilent provides this customary 
commercial license in Software and 
technical data pursuant to FAR 12.211 
(Technical Data) and 12.212 (Computer 
Software) and, for the Department of 
Defense, DFARS 252.227-7015 
(Technical Data - Commercial Items) 
and DFARS 227.7202-3 (Rights in 
Commercial Computer Software or 
Computer Software Documentation).

Safety Notices

CAUTION

A CAUTION notice denotes a 
hazard. It calls attention to an 
operating procedure, practice, or 
the like that, if not correctly 
performed or adhered to, could 
result in damage to the product or 
loss of important data. Do not 
proceed beyond a CAUTION 
notice until the indicated 
conditions are fully understood 
and met. 

WARNING

A WARNING notice denotes a 
hazard. It calls attention to an 
operating procedure, practice, or 
the like that, if not correctly 
performed or adhered to, could 
result in personal injury or death. 
Do not proceed beyond a 
WARNING notice until the 
indicated conditions are fully 
understood and met.



3 

Content

Introduction 5

Before You Begin 5
What are lipids? 6
What is lipidomics? 7
Why ion mobility mass spectrometry for lipids? 7
What will you learn from this guide? 7

Primary Lipidomics Workflow 9
Workflow Steps 9
References 10
Uses of the lipidomics workflow 10

Required Items 11
Computer Equipment 11
Software 11
Example Data Files 11

Calibrating Data 13

Correct Mass Calibration 15
Step 1. Start IM-MS Reprocessor 15
Step 2. Load selected file 16
Step 3. Set up recalibration 17
Step 4. Run recalibration 19
Step 5. Recalibrate remaining files 20
To restore original file 21

Apply Single-Field CCS Calibration 22
Step 1. Load the All Ions tune-mix file 22
Step 2. Sum the signals 24
Step 3. Calculate the Beta and TFix values 25
Step 4. Save the values to the tune-mix and sample files 26
Step 5. Repeat steps for MS1 tune-mix and sample files 28

Processing Data 29

Create Lipid PCDL 31
Step 1. Create new project 31
Step 2.Edit and run method 34
Step 3.Export to PCDL 39



Content

4

To export to CSV for Skyline 41

Find Features 44
Step 1. Add samples 44
Step 2. Edit method 48
Step 3. Extract and review features 51

Identify Compounds 52
Step 1. Set up method 52
Step 2. Specify PCDL 56
Step 3. Identify compounds 57
Step 4. Create CEF files for export 60

Analyzing Lipids 61

Create Lipidomics Experiment 63
Step 1. Create new project 63
Step 2. Create new experiment 64

Import and Group CEF Files 67
Step 1. Select data to import 67
Step 2. Group samples 68
Step 3. Filter data 70

Review Lipid Information 72
Step 1. View lipid ion mobility data 72
Step 2. Create interpretations 73
Step 3. Create a lipid matrix 76
Step 4. Plot CCS vs Mass 82

Reference Information 85
Definitions 86
Resource Apps 94
Agilent Web Site 94
Agilent Community 94



5

Introduction

Introduction 5
What are lipids? 6
What is lipidomics? 7
Why ion mobility mass spectrometry for lipids? 7
What will you learn from this guide? 7

Primary Lipidomics Workflow 9
Workflow Steps 9
References 10
Uses of the lipidomics workflow 10

1 Before You Begin

Make sure you read and understand the information in this chapter and have the necessary computer 
equipment, software and example data files before you start your analysis.

Add samples

Edit method

Create 
Lipidomics
Experiment

Import and 
Group CEF Files

Review Lipid 
Information

Create new 
project

Edit and run 
method

Export to PCDL 

Set up method

Specify PCDL

Identify 
compounds

Extract and 
review features

Create CEF files 
for export

All Ions and MS1 Files

All Ions Files

PCDL

CEF FilesCALIBRATING DATA
IM-MS Reprocessor

IM-MS Browser

Correct Mass 
Calibration

IM-MS 
REPROCESSOR

Apply 
Single-Field 

CCS Calibration
IM-MS BROWSER

CREATE LIPID PCDL
Lipid Annotator

IDENTIFY COMPOUNDS
ID Browser

FIND FEATURES
Mass Profiler

ANALYZING LIPIDS
Mass Profiler Professional

PROCESSING DATA
Lipid Annotator
Mass Profiler

ID Browser MS1 Files CEF Files

Export to CVS 
for Skyline

Optional
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To understand the specifics of the Primary Lipidomics Workflow, first familiarize 
yourself with lipids, lipidomics and the advantage of ion mobility mass spectrometry 
for lipidomics studies.

What are lipids? Lipids are a very broad, diversified group of hydrophobic or amphipathic (both 
hydrophobic and hydrophilic) small molecules including fats, oils, hormones and 
certain components of membranes grouped together because they do not interact 
appreciably with water. One type of lipid, the triglycerides, is sequestered as fat in 
adipose cells, which serve as the energy-storage depot for organisms and also 
provide thermal insulation. Some lipids such as steroid hormones serve as 
chemical messengers between cells, tissues and organs. Others communicate 
signals between biochemical systems within a single cell. 

The amphipathic nature of some lipids lets them form structures such as vesicles, 
micelles, liposomes, or membranes in an aqueous environment. Triglycerides, 
phospholipids and sphingolipids are amphipathic and consist of a polar “head” and 
a non-polar acyl, or fatty acid, tail or tails attached via an ester or amide bond to the 
head group. See an example below: 

Figure 1. Example of an amphipathic lipid - phosphatidylcholine 34:3

https://pubchem.ncbi.nlm.nih.gov/compound/24778702#section=2D-Structure

Sterol lipids and prenol lipids, on the other hand, are hydrophobic and are derived 
from isoprene units. Cholesterol is an example of a sterol lipid.

https://pubchem.ncbi.nlm.nih.gov/compound/24778702#section=2D-Structure
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1 Before You Begin
What is lipidomics?

See “Lipids” on page 89 to understand how to name the lipids with fatty acid chains.

See also www.lipidmaps.org.

What is lipidomics? Lipidomics is one of the four components that make up the field of “metabolomics” 
research. Metabolites are the end products of all biological/cellular processes, and 
“metabolome” refers to the collective set of all metabolites generated in a biological 
system (cell, tissue, organ or organism). Metabolomics is the scientific study to 
characterize and identify the metabolome. The metabolome is comprised of four 
major classes of biological molecules: sugars, amino acids, nucleotides, and lipids. 

The systematic study of the entire lipid profile of a cell/tissue/organ/organism is 
referred to as “lipidomics”. Mass spectrometry is one of the most widely used 
technologies in lipidomics research for the identification as well as quantitation of 
thousands of lipid molecules that constitute the cellular “lipidome”, the full lipid 
complement of a biological system.

Why ion mobility 
mass spectrometry 
for lipids?

Resolving isomeric species in lipidomics workflows is a huge challenge. For 
example, the possible permutations of fatty acid tail length and double bond 
locations that could describe a TG 49:1 sum composition are quite large, and 
several isomers could be present within a sample. These permutations have the 
same mass and potentially the same RT, making it difficult to differentiate them 
with traditional LC-MS methods. Performing LC-MS with ion mobility provides an 
additional dimension of separation to these experiments. 

Following LC separation and before MS detection, ions are separated based on their 
size and shape during an ion mobility experiment, resulting in different drift times. 
These drift times are used to calculate a Collision Cross Section (CCS) value or a 
rotationally averaged surface area for the ion. Adding CCS values to accurate mass 
and RT values, which are both available from traditional LC-MS experiments, 
provides better specification and more confidence when identifying lipids.

Lipidomics workflows also require MS/MS fragmentation to annotate lipids 
confidently. Detecting specific fragment ions can tell you that 15:0, 16:1, and 18:0 
are the three fatty acid tails for the TG 49:1 lipid. All Ions fragmentation is a data-
independent acquisition mode where all precursor ions are fragmented. When All 
Ions fragmentation is used without ion mobility separation, the resulting data can 
be hard to interpret because of the difficulty of linking precursor and fragment ions. 
When the technique is used with ion mobility, the fragments from the All Ions 
experiment are drift-aligned with their precursor ion, which allows for easier data 
interpretation. 
See “Lipid sum composition” on page 89.

What will you learn 
from this guide?

Agilent has several software packages commonly used for compound discovery 
and identification. The newly developed Lipid Annotator generates a lipid database 
specific to your data set, which you can use in these existing software packages. 

http://www.lipidmaps.org
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Additional tools have been added to Mass Profiler Professional (MPP) that allow you 
to evaluate the distribution of lipid classes, types, and abundances in different 
samples. See Chapter 4, “Analyzing Lipids”.

Using a sequence of these software tools, you can execute the Primary Lipidomics 
Workflow, described on the next pages. Agilent calls this the primary workflow 
because, although other lipidomics workflows do exist, their instructions do not 
appear in this guide. 
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1 Before You Begin
Primary Lipidomics Workflow

Primary Lipidomics Workflow

This guide takes you through the Primary Lipidomics Workflow, which uses both All 
Ions and MS1 data files. All Ions data is collected for a pooled QC of all your 
samples, and this data file is used to create a custom lipid database with Lipid 
Annotator. Mass Profiler finds features in each individual MS1 sample data file. 
These features are then identified in ID Browser using the lipids database created 
with Lipid Annotator based on the pooled QC sample. Or you can export the lipid 
database to a CSV file for import into Skyline for a targeted data analysis workflow.

Workflow Steps After acquiring the data, follow these Major Steps to eventually assess the lipid 
composition and abundance differences between sample sets. Each chapter gives 
you additional instructions to complete a primary task or tasks in the workflow.

Step 1. Calibrate Data 
(Chapter 2)

Step 1. Calibrate data

First, correct the mass calibration with IM-MS Reprocessor. Next, apply a single-
field CCS calibration in IM-MS Browser. 

Steps 2-4. Process Data 
(Chapter 3)

Step 2. Create lipid PCDL

Use Lipid Annotator to annotate lipids in the All Ions data files when fragment 
ions match the theoretical library, generating a database that contains accurate 
mass, retention time and CCS values. You can either export the database to a 
PCDL file for use with ID Browser or to a CSV file for import into Skyline.

Step 3. Find features 

Using Mass Profiler on MS1 data files, perform feature finding, which results in a 
feature list that includes a mass, retention time and CCS value for each feature. 

Step 4. Identify compounds

Using the PCDL from Lipid Annotator, identify the MS1 features as lipids with ID 
Browser based on accurate mass, RT and CCS values. Then return the feature 
list to Mass Profiler, where you create CEF files for export.

Step 5. Analyze Lipids 
(Chapter 4)

Step 5. Analyze lipids

With Mass Profiler Professional (MPP), lipid assessment tools are provided to 
compare the compound and abundance distribution between samples (exported 
CEF files imported to MPP). 

You can also use MPP to filter out features, leaving only the most relevant 
features. Normalizing the data in MPP corrects data for changes in RT or 
response so a single feature common to several samples is not treated. MPP 
also provides you with statistical data analysis tools for discovering significant 
differences between sample sets, although instructions are not provided in this 
guide. See “Resource Apps” on page 94.
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References Chapter 5 gives you distinctions for the important terms in chapters 1-4 and a 
listing of guides, interactive tutorials and video tutorials to supplement your 
knowledge.

Uses of the 
lipidomics workflow 

The lipidomics workflow may be used to do the following analyses:
• Compare two or more biological groups
• Find and identify potential biomarkers
• Look for biomarkers of toxicology
• Integrate the lipidomics data with other multi-omics data sets to better 

understand the systems biology
• Discover new lipids
• Develop data mining and data processing procedures that produce 

characteristic markers for a set of samples
• Construct statistical models for sample classification

Agilent enables lipidomics research for a variety of applications:
• Basic research - Identify and validate lipid biomarkers that correlate with disease 

states, as well as provide fundamental insights into biology
• Pharmaceuticals - Identify lipids and markers of toxicity for drug discovery and 

development
• Agriculture - Identify and understand metabolic pathways to optimize crop 

development, improve yields, and avoid pesticide/herbicide resistance
• Environmental studies - Identify lipids that relate to the effects of chemicals and 

other stressors in the environment on a biological system
• Biofuels - Identify lipid profiles to optimize fermentation processes and biofuel 

production
• Food/Nutrition - Identify the presence or absence of lipids that correlate with 

major food traits, such as quality, authenticity, taste, and nutritional value, and 
aid in the development of nutraceuticals
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1 Before You Begin
Required Items

Required Items

You need this computer equipment, software and the specified data files to 
implement the Primary Lipidomics Workflow:

Computer Equipment 4 Physical Cores, 32-64 GB memory and 3.5 GHz processor speed

Software Use these software programs and utilities for each Major Step of the Primary 
Lipidomics Workflow.

Step 1. Calibrate data IM-MS Reprocessor 10.0 and IM-MS Browser 10.0

Step 2. Create lipid PCDL Lipid Annotator 1.0 and PCDL Manager 8.0

Step 3. Find features Mass Profiler 10.0

Step 4. Identify compounds ID Browser 10.0 

Step 5. Analyze lipids Mass Profiler Professional 15.1 (MPP)

Example Data Files The data sets that you can use to work through the instructions in this guide are 
positive ion mobility LC/Q-TOF lipid data (both MS1 and All Ions data). You can find 
the files at Agilent SubscribeNet in the IM Lipidomics Data folder. See the part 
numbers and file names/descriptions in Table 1.

Table 1. IM Lipidomics Data Files on Agilent SubscribeNet

Agilent Part Number File Name in 
SubscribeNet

Description Data File Folder 
Name

G3335-10004 All Ions.zip Fragmentation Sample Data All Ions

G3335-10005 Stnd0_1017.zip MS1 Sample Data with no standards Nist0_1017

G3335-10006 Stnd2_1017.zip MS1 Sample Data with standards Nist2_1017

G3335-10007 Stnd4_1017.zip MS1 Sample Data with twice the amount 
of standards as in previous folder

Nist4_1017

G3335-10008 Tune Mix.zip One All Ions file with tuning data
One MS1 file with tuning data

Tune Mix

https://agilent.subscribenet.com/control/agil/download?element=11031067
https://agilent.subscribenet.com/control/agil/download?element=11031067
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Before you analytically process the data -- create 
a custom PCDL, extract features and identify 
compounds -- you must first calibrate the raw 
data. To do this, you correct mass calibration and 
then apply single-field CCS calibration. 

Correct Mass Calibration 15
Step 1. Start IM-MS Reprocessor 15
Step 2. Load selected file 16
Step 3. Set up recalibration 17
Step 4. Run recalibration 19
Step 5. Recalibrate remaining files 20
To restore original file 21

2 Calibrating Data 

Calibrating data is the first Major Step in the Ion Mobility Primary Lipidomics Workflow. This chapter 
takes you through the steps to calibrate the raw data for creating a PCDL and finding features. This 
chapter focuses on correcting mass calibration and applying a single-field CCS calibration to the 
corrected data.

CALIBRATING DATA
IM-MS Reprocessor

IM-MS Browser

Correct Mass 
Calibration

IM-MS 
REPROCESSOR

Apply 
Single-Field 

CCS Calibration
IM-MS BROWSER
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Apply Single-Field CCS Calibration 22
Step 1. Load the All Ions tune-mix file 22
Step 2. Sum the signals 24
Step 3. Calculate the Beta and TFix values 25
Step 4. Save the values to the tune-mix and sample files26
Step 5. Repeat steps for MS1 tune-mix and sample files28

For standard-mode data (All Ions and MS1 non-multiplexed data) you can use the 
PNNL PreProcessor (https://omics.pnl.gov/software/pnnl-preprocessor) to 
smooth and repair saturated data, resulting in improved performance of the data 
analysis carried out in this guide. For simplicity, this guide processes the raw data 
files with mass and CCS calibration and does no preprocessing with the PNNL 
Preprocessor. 

Additionally, if you have acquired multiplexed data, the lipid workflow in this guide 
cannot be completed until you use the PNNL Preprocessor for demultiplexing the 
data before CCS calibration.

Calibrating standard-mode data involves two steps:
• Step 1. Correct mass calibration using IM-MS Reprocessor 

The Reference Mass Calibration cannot be applied to IM-MS data during data 
acquisition as it can be for regular QTOF experiments. To recalibrate IM-MS data 
you use the IM-MS Reprocessor. Reference mass ions must be present and 
elute throughout the entire data file for this utility to apply a mass recalibration.

• Step 2. Apply single-field CCS calibration

After loading a tune-mix data file into the IM-MS Browser, you determine the Beta 
and TFix values and save them to the tune-mix file and to the sample data files 
acquired under the same settings as the tune-mix data file. During custom PCDL 
creation in Lipid Annotator and feature finding in Mass Profiler the CCS values 
are calculated using these Beta and TFix values.

Correct Mass 
Calibration

IM-MS 
REPROCESSOR

Apply 
Single-Field 

CCS Calibration
IM-MS BROWSER

https://omics.pnl.gov/software/pnnl-preprocessor 


15 

2 Calibrating Data
Correct Mass Calibration

Correct Mass Calibration

Correcting mass calibration involves five major steps and an optional one:
• Step 1. Start IM-MS Reprocessor
• Step 2. Load selected file 
• Step 3. mSet up recalibration
• Step 4. Run recalibration
• Step 5. Recalibrate remaining files
• Optional Step. Restore original file

NOTE
You may not need to correct mass calibration if your data file already recalibrated 
with good results (fewer than half the scans are missing). To find out, do step 4 
page 21. To learn how to correct mass calibration using these instructions, assume 
you need to recalibrate.

Step 1. Start IM-MS 
Reprocessor

IM-MS Reprocessor is installed during the installation of IM-MS Browser. To access 
the reprocessor for the first time, follow these instructions:
1 In the Windows Search field, type reprocess.
2 Right-click the IM-MS Reprocessor “Best Match” app.
3 Select Open.

OR
1 In the folder \Program Files\Agilent\MassHunter\Workstation\IMS, open the 

Bin folder.
2 Right-click the imsreprocess application and select Create shortcut.
3 Make sure you place the shortcut icon on the Desktop.
4 Double-click the IM-MS Reprocessor icon, .

You can now double-click the IM-MS Reprocessor icon whenever you want to open 
the Reprocessor.
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Step 2. Load selected file
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The IM-MS Data File Reprocessing Utility main window appears with the Operations 
tab open. 

Figure 2. Operations tab for the Reprocessing Utility 

Step 2. Load selected 
file

You can recalibrate the file sets in a major folder in any order -- tune mix, All Ions, 
MS1. Follow the instructions below to load the files from the data folder.
1 Click the ... button (Browse button) next to the Only this file text field. 
2 From your file folder, select any file in the folder you intend to reprocess.
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2 Calibrating Data
Step 3. Set up recalibration

This guide uses the All Ions tune-mix file, but you can select any file in any folder. 
You now see the file name as the Data file(s) to process, and you see another 
selection appear, letting you reprocess all the files in the folder.

Figure 3. Operations tab with only one file in the folder loaded

Step 3. Set up 
recalibration

In setting up the Recalibrate operation, make sure you have selected the correct 
masses for the tune mix or the samples.

Set up the operation 1 To recalibrate more than one file at a time, select All 2 IM-MS files in the same 
folder, or the selection that specifies how many files are in the folder.

2 Mark the Recalibrate check box. 
3 Clear the Recentroid check box.



2 Calibrating Data
Step 3. Set up recalibration
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Select the recalibration 
values

1 Click the Recalibrate tab.

The Recalibrate dialog box appears. See Figure 4.

Figure 4. Recalibrate tab with positive ions selected for the sample files (default)

2 Keep the Minimum abundance and m/z tolerance values the same.
3 Mark the Positive m/z check boxes for the values you want as Reference 

Masses for either the tune-mix files or the sample files. (See Note on page 15.)
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2 Calibrating Data
Step 4. Run recalibration

NOTE
Make sure to edit the positive mass values when switching between a tune-mix file 
(118, 322, 622, 922,1221and 1521) and a sample data file, which likely has only 121 
and 922 present. Replace the 121 value with 322.04873 for the tune-mix files. Don’t 
worry about marking the Negative m/z check boxes at this time. Use Figure 4 on 
page 18 for the sample files and Figure 5 for the tune-mix files.

Figure 5. Recalibrate tab with positive ions selected for the tune-mix files

Step 4. Run 
recalibration

Your new recalibration results will overwrite the previous ones.

Start the recalibration 1 Select the Operations tab.
2 Click Start.



2 Calibrating Data
Step 5. Recalibrate remaining files
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When you see the Done message at the bottom of the screen, the masses in the 
data files have been recalibrated.

Figure 6. Completed recalibration for both tune-mix files

3 If you applied the mass calibration to sample files, check them for missed ions.

For both tune-mix files and sample files, the zeros indicate all the marked ions 
are present in all the scans. Missing ions are not likely to appear for tune-mix 
files. For a sample file, if more than half the scans are missing ions, you likely 
have a bad recalibration.

4 (optional) For a bad recalibration, do these steps:
a Restore the original data file, which you can do with only one data file at a 

time, and then recalibrate. See “To restore original file” on page 21.
b If more than half the scans are still missing ions, check the data file in IM-MS 

Browser to verify that the reference mass ions meet the Rules values 
specified on the Recalibrate tab. See Figure 4 on page 18. 

Step 5. Recalibrate 
remaining files

• Repeat Steps 2-4 for the files in other folders.

Remember that for sample files you mark the positive ions in Figure 4 on 
page 18 and for tune-mix files you mark those in Figure 5 on page 19.
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2 Calibrating Data
To restore original file

To restore original 
file

Follow these steps if you think you need to revert back to the original data file after a 
bad mass recalibration.
1 Click the Special Operations tab.

Figure 7 appears.

Figure 7. Special Operations Tab

2 Make sure Restore original file is marked, or mark any of the other operations 
you want to do.

3 Click Do Operation. 

NOTE
These special operations will work only on the data file loaded into the Only this file 
field. If you mark the description for all the files in the folder, the operations will not 
be performed on the other files.
4 (optional) To see all the reprocessing and restoration operations that have been 

applied to the data file, open the ReprocessLog.txt file in the AcqData folder 
under the .d folder. See Figure 8.

 

Figure 8. ReprocessLog.txt file in Notepad
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Apply Single-Field CCS Calibration
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Apply Single-Field CCS Calibration

In this step you take the mass-calibrated tune-mix data into IM-MS Browser to 
determine the single-field collision cross section (CCS) constants, Beta and TFix, 
which the Lipid Annotator and Mass Profiler programs use to calculate CCS values. 
You apply the constants to the tune-mix files and the sample files corresponding to 
each tune-mix file. Follow these instructions for the All Ions and MS1 tune-mix and 
sample files.

Step 1. Load the All Ions tune-mix file

Step 2. Sum the signals

Step 3. Calculate the Beta and TFix values

Step 4. Save the values to the tune-mix and sample files

Step 5. Repeat steps for MS1 tune-mix and sample files

NOTE
If you have multiplexed data you must demultiplex it before doing the single-field 
calibration. You can demultiplex it in the PNNL Preprocessor.

Step 1. Load the All 
Ions tune-mix file

Be sure you have downloaded Agilent IM-MS Browser 10.0.

Start IM-MS Browser • Click the IM-MS Browser icon .
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2 Calibrating Data
Step 1. Load the All Ions tune-mix file

The Open Data File dialog box opens on top of the IM-MS Browser main screen.

Figure 9. Open Data File dialog box on top of IM-MS Browser main window

Open a tune-mix file In the tune-mix files folder, open the All Ions mass-calibrated tune-mix file.
1 Select 101719_TM_allions_0006.d.

Figure 10. Open Data File dialog box with All Ions mass-calibrated tune mix selected
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Step 2. Sum the signals
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2 Click Open to add the file to IM-MS Browser.

IM-MS Browser now contains the All Ions tune-mix data file that has been mass-
calibrated.

Figure 11. IM-MS Browser with All Ions mass-calibrated tune-mix data file

Step 2. Sum the 
signals

To sum the signals you must first select the entire TIC, then extract the frame.

1 In the File Overview pane, select the entire TIC.
2 To sum all the signals together, right-click the selected TIC.

Figure 12. Selected All Ions TIC with short-cut menu
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2 Calibrating Data
Step 3. Calculate the Beta and TFix values

3 Select Extract Frame.

You can now see the summed signal in the Drift Time vs m/z pane.

Figure 13. Summed signal after frame extraction

See Agilent 6560 Ion Mobility LC-QTOF Fundamentals Guide to learn about “frames”.

Step 3. Calculate the 
Beta and TFix values

You calculate these values through the CCS Calibration (Single-Field) pane. 

Display the CCS Calibration 
(Single-Field) pane

1 If the pane is visible when you first open IM-MS Browser, hide it and then follow 
the next instructions.

2 Click the View menu.

Figure 14. View menu

3 Select CCS Calibration (Single-Field).



2 Calibrating Data
Step 4. Save the values to the tune-mix and sample files
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The CCS Calibration (Single-Field) pane appears. Note the bottom part of the pane.

Figure 15. Location for calculating Beta and TFix values for the CCS Calibration

Find the drift times • Click Find Drift Times. See the results below.

Figure 16. Calculated Beta and TFix values

Step 4. Save the 
values to the tune-
mix and sample files

Now you save these values to the current tune-mix file and its corresponding 
sample files, in this case, the All Ions sample files.
1 Click Save or Restore.

The Save or Restore dialog box appears.

Figure 17. Save or Restore dialog box - Save to Current File highlighted
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2 Calibrating Data
Step 4. Save the values to the tune-mix and sample files

2 Click Save to Current File. 

The Beta and TFix values are saved to the tune-mix file, in this case the All Ions 
tune-mix file.

3 Click Save to Multiple Files.

The Open Data Files dialog box appears.
a Open the folder holding sample files corresponding to the tune-mix file used 

for calculating the constants, in this first instance, the All Ions sample folder.

step 3

Figure 18. Save to Data File(s) dialog box for saving Beta and TFix values to sample files

b Select all the sample files that were acquired under the exact same 
experimental conditions as the tune-mix data file you used to calculate the 
drift times and constants. (If you used the All Ions tune mix, then select the All 
Ions sample files. Only one file is present in this example All Ions sample 
folder.)

c Click Open.
4 If more than one folder contains sample files you intend to save with the tune-

mix file, repeat step 3 for each folder.
5 To close the Save or Restore dialog box, click OK.
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Step 5. Repeat steps for MS1 tune-mix and sample files
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Step 5. Repeat steps 
for MS1 tune-mix 
and sample files

• If you began these instructions with the All Ions tune-mix and sample files, 
repeat Steps 1-4 outlined on the previous pages with the MS1 files. 

The MS1 tune-mix file is the remaining file in the Tune Mix folder. The MS1 
sample files reside in the three folders with the NIST prefix.

You are now ready to use the calibrated All Ions sample file for creating a custom 
lipid database and the calibrated MS1 sample files for finding features and 
identifying compounds.
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This chapter presents the Major Steps and sub-
steps in the processing section of the lipidomics 
workflow. It assumes you have already calibrated 
the raw data for Step 1, following the instructions 
in Chapter 2, “Calibrating Data”.

Create Lipid PCDL 31
Step 1. Create new project 31
Step 2.Edit and run method 34
Step 3.Export to PCDL 39
To export to CSV for Skyline 41
Find Features 44
Step 1. Add samples 44
Step 2. Edit method 48
Step 3. Extract and review features 51

3 Processing Data

This chapter takes you through the steps for processing already calibrated data. This chapter focuses 
on using All Ions data and Lipid Annotator to create a custom lipids PCDL (Personal Compound 
Database and Library), and using MS1 data and Mass Profiler to extract features, which are identified 
with the custom lipids database and ID Browser.

Add samples

Edit method

Create new 
project

Edit and run 
method

Export to PCDL 

Set up method

Specify PCDL

Identify 
compounds

Extract and 
review features

Create CEF files 
for export

All Ions Files

PCDLCREATE LIPID PCDL
Lipid Annotator

IDENTIFY COMPOUNDS
ID Browser

FIND FEATURES
Mass Profiler

PROCESSING DATA
Lipid Annotator
Mass Profiler

ID Browser MS1 Files

Export to CVS 
for Skyline

Optional
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Identify Compounds 52
Step 1. Set up method 52
Step 2. Specify PCDL 56
Step 3. Identify compounds 57
Step 4. Create CEF files for export 60

After acquiring and calibrating the data, you follow these 3 Major Steps of the 
Primary Lipidomics Workflow to identify the lipids, which data you then pass on to 
MPP to assess the lipid composition differences between sample sets. 

Each section gives you additional instructions to complete the primary tasks in the 
processing part of the workflow.

Step 2. Create lipid PCDL Use Lipid Annotator to annotate lipids in the All Ions data files when fragment ions 
match the theoretical library, generating a PCDL that contains accurate mass, 
retention time and CCS values. The CCS values are calculated from the Beta and 
TFix values determined in Chapter 2. You can also generate a CSV file to use in 
Skyline for targeted data analysis. 

Step 3. Find features Find features according to mass, retention time and CCS values using Mass Profiler 
on MS1 data files. 

Step 4. Identify compounds Use the PCDL from Lipid Annotator with ID Browser to identify the MS1 features as 
lipids and return the compound information to Mass Profiler, where you create CEF 
files for export. 

In Chapter 4 you learn how to analyze the lipid data (Step 5) with Mass Profiler 
Professional (MPP), which provides lipid assessment tools with which to compare 
the compound distribution between samples (CEF files from Step 4 imported to 
MPP).
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Create Lipid PCDL

The second Major Step in the Primary Lipidomics Workflow, Create Lipid PCDL 
(Personal Compound Database and Library), includes three sub-steps: 
• Step 1. Create new project
• Step 2. Edit and run method
• Step 3. Export to PCDL
• Optional Step. Export to CVS for Skyline

With these steps you create a custom lipid database used to identify the 
compounds in the feature extraction list produced in Mass Profiler (Export to PCDL) 
or used to further analyze ion mobility data in Skyline (Export to CSV for Skyline).

Step 1. Create new 
project

You must use calibrated All Ions data to create your custom lipid database.

Name the new project 1 Open Lipid Annotator.

Figure 19. Lipid Annotator main window

Create new 
project

Edit and run 
method

Export to PCDL Export to CVS 
for Skyline

Optional
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2 Select Project > Create to bring up the Create a Project dialog box.

Figure 20. Create a Project dialog box

3 Type any name you want.
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Add data files and create the 
project

1 Click Add and open the All Ions calibrated data file.

If you have multiple All Ions data files that contain different lipids you will need to 
process these separately in Lipid Annotator and then manually merge the PCDLs 
together in PCDL Manager.

Figure 21. File added to custom lipid database project

2 Click Create.
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The Project View - TIC Chromatogram Viewer appears with the data files listed.

Figure 22. Project View - TIC Chromatogram Viewer

You are now ready to edit and run the method.

Step 2.Edit and run 
method

This exercise shows you how to edit the method should you choose to change 
parameter values, but you will keep the default values for this exercise. If possible, 
use the Default Method that comes with the program because these parameters 
were selected after analyzing over 60 lipid standards and achieved good results.

Edit the method 1 To make sure the default method is loaded, select Method > Reset Method to 
Default.

2 Select Method > Edit Method from the top menu.
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The Method Parameters tabs appear with the default parameter values. The first 
tab contains values for filtering features.

Figure 23. Feature Finding Parameters (default settings)

3 For this exercise keep the default values for Feature Finding Parameters.
4 Click Library Parameters and view the parameter values.
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This tab lets you set the positive/negative ion filters and the lipid class filters.

Figure 24. Library Parameters (default settings)

5 For this exercise keep the default values for the Library Parameters.
6 Click Identification Parameters and view the parameter values.
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This tab lets you choose which lipids to report.

Figure 25. Identification Parameters tab (default settings)

NOTE
Amphipathic lipids are identified by lipid class, sum composition and lipid 
constituents, if fragmentation information confirms specific fatty acid tail 
fragments. See “Lipids” on page 89 for the definitions of these terms and for lipid 
naming protocols.

7 For this exercise keep the default values for the Identification Parameters tab.

If you intend to save the values you change, then save the method. If you intend to 
bring up the new method when you open a project, then save the project to a new 
name before you exit Lipid Annotator.

Run the method Notice every tab has a Run button.
• Click Run after you complete editing the method.

Processing time should be a minute or so with the example file. With your own 
All Ions file, the time will be longer because your file contains no results folder 
from the previous user’s run.
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The Processing Data message appears.

Figure 26. Processing Data message

When processing completes, the results appear in the Feature View.

Figure 27. Feature View after run completion

To learn how to change the display and use the Lipid Annotator Tools, see 
“Resource Apps” on page 94 and find the tutorial for Lipid Annotator.

Review CCS values Notice the calculated CCS values in the Feature Table CCS column. The program 
calculated the values based on the Beta and TFix constants determined in “Apply 
Single-Field CCS Calibration” on page 22 of Chapter 2. 
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Step 3.Export to 
PCDL

At this point you export the data as a custom lipid PCDL file.

Export to PCDL 1 Select Project from the top menu.

Figure 28. Project menu

2 Select Export Match Result to PCDL...

The dialog box of the same name appears.

Figure 29. Export Match Result to PCDL dialog box

3 Click OK.

The Save As window appears. You now have the ability to name and save the 
database file.
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4 Type iii_custom lipid PCDL, where iii refers to your initials.

Figure 30. Save As window

5 Click Save.

The Export Successful message appears.

Figure 31. Export successful message

6 Click OK.

NOTE
If you want to add or delete compounds from the database you just created, load 
the file into PCDL Manager, which is included in your MassHunter software kit.

You are now ready to use this new custom lipid PCDL as a means to identify the 
features extracted with Mass Profiler in the next section.
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To export to CSV for 
Skyline

If you want to use Skyline for targeted feature extraction instead of Mass Profiler for 
untargeted feature extraction, export the file to CSV.

Export to CSV 1 Select Project from the top menu.

See Figure 28 on page 39.

2 Select Export Features to CSV...

The dialog box of the same name appears.

Figure 32. Export Features to CSV dialog box

3 Click OK.

The Save As window appears. You now have the ability to name and save the 
database file.

4 Type iii_custom lipid CSV, where iii refers to your initials.

Figure 33. Save As window

5 Click Save.
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The Export Successful message appears.

Figure 34. Export successful message

6 Click OK.

Prepare CSV file for Skyline 
import

You cannot import the CSV file into Skyline unless you do the following steps.
1 Copy the CSV file as another name, say, forskyline.csv, and open it in Excel.

You must do the steps below to have the spreadsheet look like Figure 35.

Figure 35. Excel .csv file with the correct entries.
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2 Remove all the columns that are not included Figure 35 on page 42.
3 Remove all rows that have no Molecule List Name and Precursor Name.
4 Rename columns to the names above.
5 Change “(“ to “[“ and “)” to “]”.
6 If Deuterium is present in the sample, change the “[2H]” in the Precursor Formula 

to “D”.
7 Import the file into Skyline and refer to its user guides to perform the tasks you 

want to do.
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Find Features

This is the third Major Step in the Primary Lipidomics Workflow. It uses Mass 
Profiler and comprises three sub-steps.
• Step 1. Add samples

After you launch Mass Profiler, you add the calibrated MS1 samples.
• Step 2. Edit method

This step gives you instructions for editing the method in Mass Profiler to extract 
features based on retention time, mass and CCS value.

• Step 3. Extract and review features 

Ion mobility features are unidentified compounds represented by retention time, 
mass and CCS value. In this step you run the method you created in Step 2 to 
extract these features from the data. In the next section you identify the 
compounds with ID Browser.

Step 1. Add samples You must first create a project and add samples before you edit a default method 
for the feature extraction.

Create new project 1 Launch Mass Profiler.

Figure 36. Agilent Mass Profiler main window

Add samples

Edit method

Extract and 
review features
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2 Note the method whose name is on the Title Bar.
3 Select File > Create Project.
4 For Number of groups, select 1 (Figure 37).

Figure 37. Create Project dialog box

Add calibrated MS1 samples Because there are no control samples in the MS1 files, use the following 
instructions:
1 Type the project name, iii_find lipids, where iii refers to your initials.
2 Click Add.
3 Select the calibrated files in the Nist0_1017 folder, and click Open.
4 Repeat step 2 and step 3 for the calibrated files in the other two Nist folders.
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The Create Project dialog box now contains the sample files.

Figure 38. Mass Profiler Create Project dialog box with added files

5 If the default method’s name is in the Title Bar of the main window: 
a Make sure the Open method on OK check box is marked.
b Click OK.
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At first, you see the dialog box with only commonly changed parameters 
(Figure 39).

Figure 39. Default method with commonly changed parameters

c Go to “Step 2. Edit method” on page 48.

If a different method has been loaded: 
a Make sure the Open method on OK check box is clear. 
b Click OK.
c Select Method > Reset Method to Default.
d Select Method > Edit Method.

Figure 39 appears.
e Go to “Step 2. Edit method” on page 48. 
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Step 2. Edit method One of the parameters you are going to edit is not on Figure 39 on page 47.

Edit parameters 1 Select All parameters.

You now see the default method dialog box with three tabs.

Figure 40. Default method with all parameters
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2 Click a tab, and for each tab and parameter take the action described in Table 2.

The Feature Finding/Loading Tab now looks like this.

Figure 41. Edited Feature Finding/Loading Tab

The Statistics and Filters Tab now looks like this.

Figure 42. Edited Statistics and Filters Tab

Table 2 Parameters 

For This Tab and Parameter: Take This Action:

Feature Finding/Loading Tab:

Isotope Model Select Common organic (no halogens).

Limit charge states to a range of Type 1-3

Report single ion features with charge state 
z=1

Check box marked automatically when above 
Isotope Model selected

Alignment & Normalization Tab: No edits

Statistics and Filters Tab:

Abundance > 5000
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3 Click OK.

NOTE
Changing a parameter value that is not commonly changed does not automatically 
place the parameter on the Commonly changed parameters dialog box. The 
Commonly changed parameters (not values) are always the same.

Save the method and project You can start a run from any tab of the method dialog box, but it’s wise to save both 
the method and project at this point.

1 Select Method > Save Method As.
2 Type the new method, iii_find lipids.mpm., and click Save.
3 Select File > Save Project.
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Step 3. Extract and 
review features

Now you can run the method to extract features. Do not worry if the number of 
features varies a bit from run to run. The lipid matrix results in MPP should be the 
same as shown in the next chapter.

Run method • Select Method > Run Current Method, or

Open the method and click Run.

NOTE
For these example files, the run will take around a minute or so because Results 
folders already exist (from previous user’s run).

Review features When the run is complete, the Mass Profiler main window looks like this:

Figure 43. Mass Profiler main window with feature extraction results
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Identify Compounds

In this fourth Major Step you identify features using the ID Browser within Mass 
Profiler and the custom lipid PCDL you created with Lipid Annotator. This Major 
Step comprises four sub-steps.
• Step 1. Set up method

After you launch ID Browser from Mass Profiler containing the extracted MS1 
features, you edit the parameters in the ID Browser method.

• Step 2. Specify PCDL

This is where you enter the custom lipid PCDL file you created.
• Step 3. Identify compounds 

You then run the method to match the MS1 features with the compounds in the 
PCDL and return the data to Mass Profiler, where the CEF files are created.

• Step 4. Create CEF files for export

In Mass Profiler you create the CEF files for export and then import them to 
Mass Profiler Professional (MPP) in the fifth Major Step, Analyze Lipids.

Step 1. Set up 
method

After launching ID Browser from Mass Profiler, you set up the method to identify the 
lipid compounds in the features you extracted.

Enter database search 
criteria

1 Launch ID Browser from Mass Profiler.
a Click the Identify Features menu.

Figure 44. Identify Features menu for Mass Profiler

b Select For All Features in Table...

Set up method

Specify PCDL

Identify 
compounds

Create CEF files 
for export
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The ID Browser Wizard appears on top of the main window.

Figure 45. ID Browser Wizard on top of default identification results

2 In the Compound Identification Wizard, click Next.

Figure 46. Database Search Settings - Search Criteria Tab
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3 If the default method is listed as the Identification method, go to step 4.

If the default method is not listed as the Identification method: 
a Click the Open icon.
b In the ...\Workstation\Methods\Methods\10.0 folder, select Default.m.
c Click Open.

4 Select Database Search Settings and click the Search Criteria tab.
5 Mark the Retention Time check box and the Required check box next to it.
6 Mark the CCS check box and the Required check box next to it.
7 Retain default values for the other parameters.

Figure 47. Search Criteria selections made
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Enter additional positive ion 1 In Database Search Settings, click the Positive Ions tab.

Figure 48. Positive Ions tab

2 Type H4N and click + to add it to the list of Charge carriers.

Because the PCDL from Lipid Annotator writes H4N, you need to add that to ID 
Browser, which is looking only for NH4.

Figure 49. Positive Ions tab modified
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Step 2. Specify PCDL Before saving the method, as the last set-up step you link to the custom lipid PCDL 
you created previously.

Set up identification 
workflow

1 Select Identification Workflow.

Figure 50. Identification Workflow without specified PCDL

2 To add the lipid database you created earlier in this chapter, click Add.
3 Select iii_custom lipid PCDL, and click Open.

Figure 51. Identification Workflow with custom lipid PCDL added
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Save the method 1 Click the Save icon.
2 Type iii_ID Method - Lipids, and click Save.

Figure 52. Identification Workflow with new saved method.

Step 3. Identify 
compounds

Now you are ready to run the method to identify compounds.

Run the method 1 To run the ID method, click Finish.

After ID Browser completes the identification, you see the same main screen as 
in Figure 45 on page 53 but with a few identified compounds in the table. 

2 To view identified and unidentified features in Mass Profiler, click Save and 
Return.
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You now see the main Mass Profiler window showing the list of identified and 
unidentified features.

Figure 53. Mass Profiler main window with table of identified and unidentified features

Display identified 
compounds only

1 Click Identify Features.

Figure 54. Identify Features menu

2 Select Display Identified Features Only.
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The identified compounds appear in the table and graphic (Figure 55).

Figure 55. Identified features only in three sample sets

At this point you may want to save the project with the feature finding and 
identification results.
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Step 4. Create CEF 
files for export

If you intend to analyze the sample files with the 84 identified lipid compounds, you 
must convert the files to CEF files and import them into MPP. See Chapter 4.
1 To see the menu item for creating CEF files for export, click File.

Figure 56. File menu

2 Select Export Each Sample to CEF.

A dialog box appears asking if you want to average sample values.

Figure 57. Dialog box for averaging sample values

3 Click No.

A dialog box appears locating the CEF files.

Figure 58. Dialog box for locating the CEF files

4 Click OK.

You can now import and analyze the files in MPP, as described in Chapter 4. 
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4 Analyzing Lipids

This chapter takes you through the tools you need to compare lipid classes in different sample sets 
using Agilent Mass Profiler Professional.

Create 
Lipidomics
Experiment

Import and 
Group CEF Files

Review Lipid 
Information

ANALYZING LIPIDS
Mass Profiler Professional
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In the final Major Step within the Primary Lipidomics Workflow you work with MPP 
lipid tools to compare lipid compositions between sample sets. This workflow 
comprises three sub-steps.
• Step 1. Create lipidomics experiment

After you launch MPP, you create a lipidomics experiment into which you load 
the CEF files.

• Step 2. Import and group CEF files

In this step you load and group the CEF files you created in Mass Profiler, filter 
the data and produce an abundance vs sample plot.

• Step 3. Review lipid information

You can review the lipids spreadsheet to take into account the ion mobility data. 
You can also distinguish among your sample sets by looking at the compound 
and abundance distribution of the lipid standards in the interpretation groups 
you’ve set up, which contain either averaged or non-averaged sample data. And 
you can generate a CCS vs Mass plot to see the lipid class differences for ion 
mobility data.

This fifth Major Step, Analyzing Lipids, completes the Primary Lipidomics Workflow. 

Create 
lipidomics

experiment

Import and 
group CEF files

Review lipid 
information
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Create Lipidomics Experiment

To create a lipidomics experiment you first create a new project and then a new 
experiment.

Step 1. Create new 
project 

After launching Mass Profiler Professional (MPP), you set up a project.
1 Launch MPP.

The MPP main window appears with the Startup dialog box.

Figure 59. Startup dialog box in MPP main window

2 Select Create new project and click OK.
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The Create New Project dialog box appears.

Figure 60. Create New Project dialog box

3 Type the new project name, iii_IM Lipid Project, where iii represents 
your initials.

4 Click OK.

Step 2. Create new 
experiment

The Experiment Selection Dialog appears.

Figure 61. Experiment Selection Dialog box

1 Click OK to create a new experiment.

The Experiment description page of the New Experiment dialog box appears with 
no entries. 

2 Type the Experiment name as iii_IM Lipid Expt.
3 For the Experiment type, select Lipidomics from the list.
4 For the Workflow type, select Data Import Wizard from the list.

You now see the Experiment description page with entries from step 2 to step 4 
(Figure 62 on page 65).

If you intend to do any statistical analyses on the data, you can select Analysis: 
Significance Testing and Fold Change from the Workflow type list now, or wait to 
select it from the Workflow menu when the main window appears after 
completing the Data Import Wizard.
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The instructions that follow assume you have selected Data Import Wizard as 
the Workflow type.

Figure 62. Experiment description with entries

5 Click OK.
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The first step of the Experiment Creation Wizard appears. 

Figure 63. Step 1 of MS Experiment Creation Wizard
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Import and Group CEF Files

After naming and describing the new project and experiment, you go through the 
Experiment Creation Wizard (Data Import Wizard) to import and group the CEF files 
you created in Mass Profiler. You then filter the data.

Step 1. Select data to 
import

You now work with the Experiment Creation Wizard that appeared after you clicked 
OK in New Experiment dialog box. You first select the data source, the organism 
and the data to import, as shown below.
1 Select Masshunter Qual (.CEF) as the Data Source.
2 For the Organism, select Homo sapiens.
3 Click Select Data Files, select the MS1 files in the Nist0_1017 folder and click 

Open.

Figure 64. Step 1 of MS Experiment Creation Wizard with data files

4 Click Next twice.
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The Experiment Grouping dialog box appears.

Figure 65. Experiment Grouping (Step 5)

Step 2. Group 
samples

1 Click Add Parameter.

The Edit Parameter Values dialog box appears. 
2 For the Parameter name, type Standard Concentration.

You now group the nine samples into sets, each with a different standard. See 
Figure 66 on page 69 for the entries given below.

3 Select the first three samples with no standards, and click Assign Values.
4 Type No standard and click OK.
5 Select the second set of samples, and click Assign Values.
6 Type Standard 2 and click OK.
7 Select the third set of samples, and click Assign Values.



69 

4 Analyzing Lipids
Step 2. Group samples

8 Type Standard 4 and click OK.

Figure 66. Add/Edit Experiment Parameter dialog box

9 Click OK to see a listing of the groups.

Figure 67. Experiment Grouping after adding groups
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Step 3. Filter data 1 Click Next.

The Filtering step appears. Make the changes below. See Figure 68.
2 Clear the Minimum absolute abundance check box.
3 Change the Minimum number of ions to 1.

Figure 68. Filtering Step after changes

4 Click Next four times, then click Finish.
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The MPP main window appears with an abundance vs sample profile on the 
display.

Figure 69. MPP main window with log normalized abundance vs samples

For these samples, normalization cannot be set up because internal standards were 
not included in the study.

You are now ready to move on to the next section, “Review Lipid Information” on 
page 72.
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Review Lipid Information

This section shows you how to review the Drift Time (DT), the CCS value and the ion 
species for each lipid. Once you create interpretations with your experiment 
groupings, you also learn to use the lipid matrix tool to view the relative abundance 
of the standards and other lipids in the samples.

Step 1. View lipid ion 
mobility data

1 In the top icon toolbar, click the Spreadsheet icon, 

The spreadsheet with all the sample data appears.

Figure 70. Spreadsheet View of the main MPP window

2 Note the Drift Time (DT), CCS values and ion species for each lipid.

Each ion species listed is the one whose CCS has been calculated for the 
corresponding lipid.

To add columns to the Spreadsheet View, right-click the All Entities item in Project 
Navigator on the left and then select Inspect List.
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Step 2. Create 
interpretations

An interpretation is a grouping of experiment conditions for display and analysis. In 
this step you create two interpretations -- averaged and non-averaged.
1 In the Workflow menu under Experiment Setup, click Create Interpretation.

Step 1 of the Create Interpretation wizard appears.

Figure 71. Step 1 of the Create Interpretation wizard - Select parameters

2 Click Next until you reach the next to last page (Step 3).

Figure 72. Step 3 of the Create Interpretation wizard - Select conditions
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Notice that both Averaged and Non-Averaged options have been selected. This 
selection of default settings creates two separate interpretations.
3 Click Next to reach the last page (Step 4).

Figure 73. Last Step of Create Interpretation wizard - Save Interpretation

4 Click Finish.
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Two interpretations are created, non-averaged and averaged.

Figure 74. MPP main window - non-averaged interpretation, Standard concentration (Non-averaged)
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Step 3. Create a lipid 
matrix

To view the abundance of different lipids, you use the lipid matrix tool.
1 In the Interpretation list, double-click the averaged interpretation, Standard 

concentration.

Figure 75. MPP main window - averaged interpretation, Standard concentration

2 Under Results Interpretations in the Workflow menu, select Create Lipid Matrix.
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Step 1 of the Create Lipid Matrix wizard appears.

Figure 76. Create Lipid Matrix wizard - Input Parameters

The interpretation you see is the interpretation highlighted in the Project 
Navigator, which in this case is the averaged Standard concentration.

3 Click Next.

Step 2 of the wizard appears, which displays 3 graphics showing relative 
abundance in the sample sets. The first that appears is the Sum Composition.

Figure 77. Create Lipid Matrix wizard - Output Views - Sum Composition

To see these graphics more clearly, you will view them in the main window.
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4 Click Next.

The Save Lipid Matrix dialog box appears.

Figure 78. Save Lipid Matrix dialog box

5 Click Finish.

The main window appears with the Lipid display.
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6 From the Lipid Classes list, select PC.

Figure 79. MPP main window - Lipid display for averaged concentration interpretation of the PC lipid class

This graphic display shows the different levels of abundance in the standard-
spiked samples for each of the lipids in the PC class. Blue means less 
abundance. Red means strong abundance, and the colors between blue and red 
mean increasing degrees of abundance, from yellow to orange to red. See the 
Legend to the right of the matrix. 

7 To see the full name of a lipid in the matrix and its abundance, pass the mouse 
over the rectangle of interest.

Notice that for the standard lipid PC 14:1_14:1, the abundance increases from no 
standard > standard 2 > standard 4.

8 Click the Lipid Class tab.



4 Analyzing Lipids
Step 3. Create a lipid matrix

80

A different graphical display appears.

Figure 80. MPP main window - Lipid class display for averaged concentration interpretation

Even though there is one lipid standard spiked and found for the PC and SM 
classes, the results are muted because in this graphic you are viewing the 
results for all the lipids together in the class. Blue means less abundance, yellow 
or orange means some abundance, and red means strong abundance. See the 
Legend to the right of the matrix. 

9 Click the Sum Composition tab.
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Yet another graphical display appears.

Figure 81. MPP main window - Sum Composition display for an averaged concentration interpretation

The sum composition shows the abundance (log of normalized abundance) of 
each lipid in a class for each sample set. Again, see the Legend to the right of the 
matrix for the color meanings.

The x-axis shows the number of carbons in the acyl tail groups for each lipid in a 
class. For example, the lipids in the ACar class have fewer carbons in their tails 
than the lipids in the other classes, and the lipids in the TG class have more 
carbons than the others, primarily because they have 3 tails and the ACar lipids 
have only one.

Also notice that PC 28:2 increases its abundance from No standard > Standard 2 
> Standard 4.
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Step 4. Plot CCS vs 
Mass

In addition to viewing lipid and lipid class relationships in MPP, you can generate 
plots with ion mobility data. 

In this step you learn how to generate a CCS vs Mass plot.
1 In the MPP main window, click the Mass vs RT Plot icon, 

The plot display appears in the MPP window.

Figure 82. Mass vs RT plot in MPP window

2 From the X-Axis list, select Mass.
3 From the Y-Axis list, select CCS.
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4 Analyzing Lipids
Step 4. Plot CCS vs Mass

You now see the CCS vs Mass plot.

Figure 83. CCS vs Mass plot in MPP main window

NOTE
Each lipid class is color-coordinated according to the legend on the right. Note how 
the lipids are grouped together according to class and structure (CCS values).
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5 Reference Information

This chapter consists of definitions of ion mobility, lipidomics and software terms, as well as 
references to Agilent publications that can help you use Agilent products to perform lipidomics 
analyses.

IM‐MS Browser
•Apply Single Field 
CCS Calibration for 
al l  data fi les
•Visually Evaluate    
Data

Lipid Annotator
•Annotate All  Ions 
IM‐MS Data 
•Generate  accurate 
mass, retention 
time, and CCS 
database

Mass Profiler
•Feature Find on MS1 
Data
•Align features across 
al l data fi les

ID Browser
•Identify features 
with accurate mass, 
retention time, and 
CCS database from 
Lipid Annotator

Mass Profiler 
Professional
•Statistically evaluate 
results 
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Definitions Review of the terms and definitions presented in this section helps you understand 
the Agilent software wizards and the lipidomics workflow. Because this guide does 
not show you MPP statistical tools, refer to the Agilent Metabolomics Workflow 
Guides mentioned in “Resource Apps” on page 94 for these definitions.

Abundance When mentioned in this guide, it usually refers to the log normalized abundance, or 
concentration, of the identified lipids in the sample set.

Alignment Adjustment of the chromatographic retention time of eluting components to 
improve the data correlation among data sets, based on the elution of specific 
component(s) that are (1) naturally present in each sample or (2) deliberately added 
to the sample through spiking the sample with a known compound or set of 
compounds that do not interfere with the sample.

All Ions data Ion mobility data files containing both MS1 and fragmentation data, an option 
specified for acquisition. All Ions data is used in Lipid Annotator because the 
fragmentation data is necessary for lipid annotation. See “MS1 data” on page 91.

Beta and TFix values Constants similar to the slope and intercept of a straight line, determined with tune-
mix data and used to determine CCS values for either All Ions data or MS1 data.

Biomarker An organic compound that is an indication of a biological state and which by 
analytical measurement of its presence and concentration in a biological sample 
indicates a normal or altered function of higher level biological activity.

Calibration Using a standard with known accuracy to determine the values of other compounds 
present in the sample.

CCS Collision cross section (CCS) is the rotationally averaged surface area of the ion. 
The measured drift time of an ion from an ion mobility experiment is used along 
with other experimental parameters (temperature, pressure, drift tube length and 
voltage), information about the ion (mass and charge) and buffer gas (mass and 
number density) to calculate the CCS value. CCS values serve as additional 
descriptors in analytical workflows, adding not only more specificity, but also 
unique structural information about the ion that is not reflected in retention time or 
mass from traditional LC-MS experiments.

CEF file A binary file format called a Compound Exchange Format (CEF) that is used to 
exchange data between Agilent software programs and between Agilent programs 
and third-party programs. In the lipidomics workflow, CEF files are used to share 
molecular features between Mass Profiler and Mass Profiler Professional.

Charge carriers Specific ions, either positive or negative, such as +NH4 or -Cl.

Charge state Actual charge, either +N or -N, where N is the number of the charge.

Composite sample In Mass Profiler, features from all the samples plotted together on the X-Y plot (i.e., 
m/z vs RT) are called the “composite sample”.
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Compound A lipid that may be individually referred to as a compound, feature, element, or entity 
during the various steps of the lipidomics data analysis.

Condition Another term for one of several values within a parameter for which exist 
correlating samples. Condition may also be referred to as a parameter value during 
the various steps of the lipidomics data analysis. 

Database A saved set of information that includes all of the important qualities of a feature 
used to identify a feature as a particular compound. One of the lipidomics workflow 
steps is to create a custom lipid database for identifying unknown lipids.

Demultiplexed data As you set up to acquire ion mobility data, you can select either standard IM mode 
or multiplexed IM mode. To take multiplexed data through the lipidomics workflow 
you must first demultiplex the data. This process combines the signals from the 
multiple ion pulses, which increases the sensitivity of the measurement. Also see 
“Multiplexed data” on page 91 and “Standard-mode data” on page 93.

Dependent variable An element in a data set that can only be observed as a result of the influence from 
the variation of an independent variable. For example, in a typical discovery 
experiment the lipid profiles of a set of human serum samples make up the 
dependent variables of a study whose independent variable is the disease state.

Element A lipid that may be individually referred to as a compound, feature, element, or entity 
during the various steps of the lipidomics data analysis.

Entity A lipid that may be individually referred to as a compound, feature, element, or entity 
during the various steps of the lipidomics data analysis.

Experiment Data acquired in an attempt to understand causality, where tests or analyses are 
defined and performed on an organism to discover something that is not yet known, 
to demonstrate proof of something that is known, or to find out whether something 
is effective.

Experiment grouping Grouping samples into sets with the same qualities, conditions or treatments.

Externality A quality, attribute, or state that originates and/or is established independently from 
the specimen under evaluation.

Extraction The process of retrieving a deliberate subset of data from a larger data set whereby 
the subset of the data preserves the meaningful information as opposed to the 
redundant and less meaningful information. Also known as data extraction.

Feature Independent, distinct characteristics of phenomena and data under observation. 
Features are an important part of the identification of patterns within the data, 
whether processed by human intelligence, or artificial intelligence programs such 
as Agilent MassHunter Mass Profiler and Agilent Mass Profiler Professional. In 
lipidomics analysis a feature is a lipid and may be individually organized (extracted) 
by mass, abundance and CCS values before it is identified.
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Feature extraction The reduction of data size and complexity through the removal of redundant and 
non-specific data by using the important variables (features) associated with the 
data. Careful feature extraction yields a smaller data set that is more easily 
processed without any compromise in the information quality. This is part of the 
filtering and statistical analysis processes employed by Agilent Mass Profiler for the 
lipidomics workflow.

Frame In ion mobility mass spectrometry, data acquisition is the ultra-high-speed signal 
digitization in the detector, which acquires arrival-time spectra, called transients, at 
a rate of one per 120 usec. To capture the speed of peaks being separated by the 
ion mobility drift tube, it is necessary to record each transient individually. A full drift 
spectrum of 60 msec is the result of 500 TOF transients, often referred to as the 
Frame transient. The acquisition system then sums Frame transients until the 
period specified by the Frame data rate for saving the file is reached. The mass and 
drift time data within this period is known as the Frame. See the Agilent 6560 Ion 
Mobility LC/QTOF Fundamentals Guide for a visual explanation of a Frame.

Frame extraction The process of summing the signals within a selected region of the Frame as 
implemented in the IM-MS Browser.

Filtering The process of establishing criteria by which entities are removed (filtered) from 
further analysis during the lipidomics workflow.

ID Browser Agilent software that annotates the feature lists by assigning compound names 
based on database searching and spectral matching. It can be launched from either 
Mass Profiler or Mass Profiler Professional to assign compound names to features.

Identified compound Chromatographic components that have an assigned identity, such as compound 
name and molecular formula, based on prior assessment or comparison with a 
database. See also “Unidentified compound” on page 93.

IM-MS Browser Agilent software that displays and lets you analyze ion mobility data.

IM-MS Reprocessor Agilent software designed to help you correct mass calibration in ion mobility data.

Independent variable An essential element, constituent, attribute, or quality in a data set that is 
deliberately controlled in an experiment. For example, in a typical discovery 
experiment the lipid profiles of a set of human serum samples make up the 
dependent variables of a study whose independent variable is the disease state. An 
independent variable may be referred to as a parameter and is assigned a 
parameter value during the various steps of the lipidomics data analysis.

Interpretation Groupings of samples based on the experimental parameters. By default in MPP, 
when you open an experiment, the “All Samples” interpretation is active. You can 
click another interpretation to activate it. To learn how to create an interpretation, 
see “Step 2. Create interpretations” on page 73.
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Ion mobility An analytical technique that separates ions based on their mobility through a drift 
gas. For drift tube IM, the velocity of the ion is the result of counteracting forces. The 
driving force is an electric field established along the length of the drift tube. The 
decelerating force arises from collisions with the drift gas within the tube, affected 
by the ion’s shape and size, as well as by the number density of gas molecules in the 
drift tube. Ions that manifest a higher velocity have higher ion mobility.

Isotope model The kind of isotopic envelope pattern a given data set may contain. The isotope 
model controls how the assignment algorithm uses peak abundances in addition to 
peak spacing when it tries to group peaks into isotope clusters (from which it can 
then determine the charge state). For example, an isotope model could be “Common 
organic compounds” or “Common organic (No Halogens)”. See “Method” on 
page 91.

Lipid Annotator Agilent software designed to annotate lipids based on matching fragmentation data 
with theoretical fragmentation spectra. Lipid Annotator provides a pie chart 
summary of lipid classes present in the sample and creates a custom lipid 
database, or PCDL.

Lipids Lipids are a very broad, diversified group of hydrophobic or amphipathic (both 
hydrophobic and hydrophilic) small molecules that are critically involved in 
maintaining structural integrity of cellular membranes, serve as cellular energy 
stores and are also key intermediates of several signal transduction pathways. The 
amphipathic nature of some lipids lets them form structures such as vesicles, 
liposomes, or membranes in an aqueous environment. These lipids are named 
according to their “head group” component and their acyl tails.

Lipid class Categories of lipids organized by their component compounds. 
Hydrophobic lipids, such as Cholesterol, belong in their own class. Amphipathic 
lipids contain the same backbone or “head group” component, such as Carnitine, 
Glycerol or Sphingosine, and 1-3 long-chain acyl groups from fatty acids attached to 
an alcohol group or an amine on the “head group”. Some examples of lipid classes 
for these three “head groups” are Acylcarnitine (ACar), Triacylglycerol (TG) Ceramide 
Non-hydroxy Fatty Acid Sphingosine (CerNS). 

Lipid constituent A lipid constituent of a lipid class is a lipid whose name includes 
its class abbreviation and the individual number of acyl chains, carbons and double 
bonds. For example, the name PC 16:0_18:2, indicates this constituent is a 
phosphatidylcholine with two attached acyl tails, one of 16 carbons and no double 
bonds and one of 18 carbons and 2 double bonds. TG 16:0_16:1_18:1 is a triacyl 
glycerol with 3 acyl tails, one with 16 carbons and no double bonds, one with 16 
carbons and one double bond and one with 18 carbons and one double bond. 

Lipid sum composition A lipid or set of lipids can also be identified by their class 
and the total number of carbons and double bonds in the acyl chain or chains -- 
their sum composition. For example, PC 34:2 is a sum composition of phosphatidyl-
choline with a total of 34 carbons and two double bonds in the attached acyl 
groups. Another example of a sum composition is TG 50:2, which has a total of 50 
carbons and 2 double bonds in the attached acyl groups. 
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For a given sum composition one or multiple lipid constituents are possible based 
on evidence in the fragmentation spectra. These are listed in the bottom table on 
the Match Details view of Lipid Annotator. If only one lipid constituent is listed, 
evidence for only those specific fragment ions was found in the fragment spectra 
(e.g., for PC 34:2 if only PC 16:0_18:2 is listed, then only fragments for the acyl 
groups 16:0 and 18:2 were found). If multiple constituents are listed, then multiple 
fragment ions were detected in the fragment spectra for all the acyl groups (e.g., for 
TG 50:2 if TG 16:0_16:1_18:1, TG 15:0_17:1_18:1 and TG 16:0_16:0_18:2 are listed, 
then fragments were detected for the 15:0, 16:0, 16:1, 17:1, 18:1, and 18:2 acyl 
groups). 

The percentages in the table represent the comparative abundance of each of the 
unique fragment ions, and the dominant constituent is the one present in the 
greatest abundance.

Lipidome The complete set of lipids found within a biological sample.

Lipidomics Identification and quantification of cellular lipids from an organism in a 
specified biological situation. The study of lipids is a subset of metabolomics.

Mass Profiler Agilent software for extracting features from data files. This software serves as the 
batch processing software tool for ion mobility data. Once extracted, the features 
can be identified using the embedded ID Browser software tool. Mass Profiler also 
supports differential analysis for two sample groups and exports CEF files for more 
statistical analysis in MPP.

Mass Profiler Professional 
(MPP)

Agilent software with many statistical and display tools for analyzing identified and 
unidentified compounds. Its lipid matrix tool is especially useful for comparing 
abundances of compounds within and between lipid sample sets of differing 
qualities, conditions or treatments.

Mass calibration In mass spectrometry, tuning compounds are used to adjust the mass scale and 
relative intensities of the mass spectral peaks.

Mass variation The mass to charge (m/z) resolution of the mass spectral data enables the 
identification of compounds with nearly identical, or identical, chromatographic 
behavior by adjusting the m/z range for extracting ion chromatograms.

Mean The numerical result of dividing the sum of the data values by the number of 
individual data observations.

Metabolism The chemical reactions and physical processes whereby living organisms convert 
input compounds into living compounds, structures, energy and waste.

Metabolites Small organic molecules that are intermediate compounds and products produced 
as part of metabolism. Metabolites are important modulators, substrates, by-
products and building blocks of many different biological processes. They are 
typically in the range of 50 to 600 Da. 
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Metabolome The complete set of small-molecule metabolites that may be found 
within a biological sample. 

Metabolomics The process of identification and quantification of all metabolites of 
an organism in a specified biological situation. The study of the metabolites of an 
organism presents a chemical “fingerprint” of the organism under the specific 
situation. See “Metabonomics” for the study of the change in the metabolites in 
response to externalities.

Metabonomics The metabolic response to externalities such as drugs, 
environmental factors, and disease. The study of metabonomics by the medical 
community may lead to more efficient drug discovery and to individualized patient 
treatment. Meaningful information learned from the metabolite response can be 
used for clinical diagnostics or for understanding the onset and progression of 
human diseases. See “Metabolomics” for the identification and quantitation of 
metabolites.

Method A procedure using specified, but modifiable, values of known parameters to process 
data.

MS1 data Data file containing only MS level data (i.e., no fragmentation data).

Multiplexed data IM data can be acquired in multiplexed mode, which is specified during data 
acquisition. In multiplexed mode multiple packets of ions are sent into the drift tube 
for each frame vs. a single packet during standard mode. Both 3-bit and 4-bit 
multiplexing are available options that result in either 4 or 8 packets of ions per 
frame. (See “Frame” on page 88.) Trap fill time must be reduced to 3-4 ms to fit the 
multiple packets within a typical maximum drift time frame of 60 ms. Also see 
“Demultiplexed data” on page 87 and “Standard-mode data” on page 93.

Multi-omics Biological analysis approach in which the data sets are multiple “omes”, such as the 
genome, proteome, metabolome or lipidome. In other words, it is the use of multiple 
“omics” technologies to study life in a concerted way. By combining these “omes”, 
researchers analyze complex biological big data to find novel associations between 
biological entities, pinpoint relevant biomarkers and build elaborate markers of 
disease and physiology. Ion mobility is an excellent tool for multi-omics studies 
because it provides an additional dimension of separation for these complex 
samples. Additionally, each “omics” class of compounds contains distinct structural 
characteristics that manifest in class separation on the plot of CCS values vs. 
mass.

Parameter Another term for an independent variable. Referred to as a parameter or parameter 
name and is assigned a parameter value during the various steps of the lipidomics 
data analysis. 

Parameter value Another term for one of several values within a parameter for which exist 
correlating samples. Parameter value may also be referred to as a condition during 
the various steps of the lipidomics data analysis. See also “Condition” on page 87.



5 Reference Information
Definitions

92

PCDL PCDL stands for Personal Compound Database and Library. Agilent has designed a 
number of programs for creating and managing PCDL’s, including Pathways to 
PCDL, PCDL Manager and Lipid Annotator. PCDL’s are then used for database 
searching and spectral library matching with the Agilent ID Browser software.

PNNL Preprocessor A software program designed by the Pacific Northwest National Laboratory (PNNL) 
in conjunction with Agilent for the purposes of preprocessing IM data prior to data 
analysis. Smoothing, saturation repair, and demultiplexing are a few of the 
techniques available in the PNNL Preprocessor.

Polarity Positive or negative mode used for mass spectral data acquisition.

Quality A feature, attribute, and/or characteristic element of a sample. The quality’s 
analytical result shows the sample is representative of the larger specimen to a 
high degree of certainty.

Recalibration If an application requires the best possible mass accuracy, a recalibration may need 
to be applied to the data file. To perform a recalibration, reference mass ions must 
be present throughout the entire analytical run. An IRM (internal reference mass) 
recalibration can then be carried out with the IM-MS Reprocessor utility, which 
stores the new mass calibration coefficients in the data file for use in other software 
applications.

Reduction The process whereby the number of variables in a data set is decreased to improve 
computation time and information quality, e.g., an extracted ion chromatogram 
obtained from GC/MS and LC/MS data files. Reduction provides smaller, viewable 
and interpretable data sets by employing feature selection and feature extraction. 
Also known as dimension reduction and data reduction. This is part of the filtering 
and statistical analysis processes employed by Agilent Mass Profiler and by Agilent 
Mass Profiler Professional.

Replicate Collecting multiple identical samples from a population to obtain a measured value 
that more closely approximates the true value.

Sample A part, piece, or item that is taken from a specimen and understood as being 
representative of the larger specimen (e.g., blood sample, cell culture, body fluid, 
aliquot) or population. An analysis may be derived from samples taken at a 
particular geographical location, taken at a specific period of time during an 
experiment, and taken before or after a specific treatment. A small number of 
specimens used to represent a whole class or group.

Single-field CCS calibration A method for calculating reliable CCS values. A data file is acquired for tune-mix 
ions that utilizes the exact same IM-MS settings used for the analytical run. This 
tune-mix data file is processed in IM-MS Browser to determine the Beta and Tfix 
single-field CCS calibration coefficients. These values are then applied to the 
analytical run so each feature’s drift time, mass, and charge can be easily converted 
into a CCS value during feature finding. 
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Specimen An individual organism, e.g., a person, animal, plant, or other organism, of a class or 
group that is used as a representative of a whole class or group.

Spike The specific and quantitative addition of one or more standard compounds to a 
sample.

Standard A chemical or mixture of chemicals selected as a basis of comparing the quality of 
analytical results or of measuring and compensating for the precise offset or drift 
incurred over a set of analyses.

Standard deviation A measure of variability among a set of data that is equal to the square root of the 
arithmetic average of the squares of the deviations from the mean. A low standard 
deviation value indicates that the individual data tend to be very close to the mean, 
whereas a high standard deviation indicates that the data is spread out over a larger 
range of values from the mean.

Standard-mode data This term refers to IM data that is acquired without multiplexing. See “Multiplexed 
data” on page 91.

State A set of circumstances or attributes characterizing a biological organism at a given 
time. A few sample attributes may include temperature, time, pH, nutrition, 
geography, stress, disease, and controlled exposure.

TIC Total Ion Current

Tune mix A solution made up of compounds of known masses; used to optimize conditions 
for producing the best resolution and highest signal in a mass spectrometer. Used 
with IM-MS Reprocessor to correct the mass calibration of raw IM data. Used for 
single-field CCS calibration to calculate the Beta and TFix constants.

Unidentified compound Chromatographic components that are only uniquely denoted by their mass, 
abundance and retention times, or in the case of ion mobility data, their CCS values, 
and that have not been assigned an identity, such as compound name and 
molecular formula. Unidentified compounds are typically produced by feature 
finding and deconvolution algorithms. See also “ID Browser” on page 88.

Variable An element in a data set that assumes changing values, i.e., values that are not 
constant over the entire data set. The two types of variables are independent and 
dependent.

Wizard A sequence of dialog boxes presented by Agilent software programs that guide you 
through well-defined steps to enter information, organize data, and perform 
analyses.
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Resource Apps MassHunter software includes a Resource App from where you can access relevant 
resource material. Some of these guides can also be found on www.agilent.com.

These guides, tutorials and videos help you use Agilent products for lipidomics 
analyses. For citations to Agilent application notes, presentations, product 
brochures, technical overviews, and software written especially for metabolomics 
analyses but also useful for lipidomics analyses, see the Agilent Metabolomics 
Discovery Workflow Guide. 

MassHunter Mass Profiler 
Professional Resources

• Agilent G3835AA MassHunter Mass Profiler Professional Software Quick Start 
Guide

• Agilent G3835AA MassHunter Mass Profiler Professional Software 
Familiarization Guide

• Agilent G3835AA MassHunter Mass Profiler Professional Software Application 
Guide

• Agilent Mass Profiler Professional - User Manual
• Agilent Getting Started with MPP
• Agilent MPP Statistics and Machine Learning
• Agilent MPP Training Videos
• Agilent Metabolomics Discovery Workflow Overview
• Agilent Metabolomics Discovery Workflow Guide

TOF and Q-TOF LC/MS 
Resource App

• Agilent Lipid Annotator eFam

Agilent Web Site This guide is available from www.agilent.com. 
• Metabolomics: Approaches Using Mass Spectrometry 

 (Agilent publication 5990-4314EN, October 27, 2009)

Agilent Community

To get answers to your questions, join over 10,000 users in the Agilent Community. 
Review curated support materials organized by platform technology. Ask questions 
to industry colleagues and collaborators. Get notifications on new videos, 
documents, tools, and webinars relevant to your work.

https://community.agilent.com

http://www.chem.agilent.com/Library/primers/Public/5990-4314EN.pdf
https://community.agilent.com/
www.agilent.com
www.agilent.com
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